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1. n'keyo la[;k (255) dk gsDlkMsfley :i 

D;k gS \ 

 
1. What is the hexadecimal equivalent of 

decimal number (255) ? 

(A) FE  (A) FE 

(B) FF  (B) FF 

(C) F0  (C) F0 

(D) FA  (D) FA 

2. gsDlkMsfley la[;k (2A)16 dk n'keyo 

:i D;k gS \ 

 
2. What is the decimal equivalent of 

hexadecimal number (2A)16 ? 

(A) 40  (A) 40 

(B) 41  (B) 41 

(C) 42  (C) 42 

(D) 43  (D) 43 

3. gsDlkMsfley la[;k (C)16 dk ckbujh :i 

D;k gS \ 

 
3. What is the binary equivalent of 

hexadecimal number (C)16 ? 

(A) 1010  (A) 1010 

(B) 1011  (B) 1011 

(C) 1100  (C) 1100 

(D) 1101  (D) 1101 

4. vkWDVy la[;k (25)8 dk ckbujh :i D;k gS \ 

 
4. What is the binary equivalent of octal 

number (25)8 ? 

(A) 10101  (A) 10101 

(B) 100101  (B) 100101 

(C) 11001  (C) 11001 

(D) 11101  (D) 11101 
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5. daI;wVj esa MsVk dh lcls NksVh bdkbZ D;k gS \ 

 
5. What is the smallest unit of data in a 

computer ? 

(A) ckbV  (A) Byte 

(B) fcV  (B) Bit 

(C) fucy  (C) Nibble 

(D) oMZ  (D) Word 

6. çkslslj dh xfr ekius ds fy, fdl bdkbZ dk 

mi;ksx fd;k tkrk gS \ 

 
6. What unit is used to measure processor 

speed ? 

(A) ckbV  (A) Byte 

(B) gVZ~t (Hz)  (B) Hertz (Hz)  

(C) fcV  (C) Bit 

(D) fiDlsy  (D) Pixel 

7. C Hkk"kk ds fy, lkekU;r% dkSu&lk 

vuqoknd ç;ksx gksrk gS \ 

 
7. Which translator is commonly used for 

C language ? 

(A) dEikbyj  (A) Compiler 

(B) baVjçsVj  (B) Interpreter 

(C) vlsacyj  (C) Assembler 

(D) dUoVZj  (D) Converter 

8. dkSu&lk vuqoknd =qfV [kkstus (fMcfxax) 

ds fy, vf/kd mi;qä gS \ 

 
8. Which translator is more suitable for 

debugging ? 

(A) dEikbyj  (A) Compiler 

(B) baVjçsVj  (B) Interpreter 

(C) vlsacyj  (C) Assembler 

(D) mi;qZDr esa ls dksbZ ugha  (D) None of the above 
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9. dkSu&lk lkekU;r% vf/kd rst gksrk  

gS \ 

 
9. Which is generally faster in  

execution ? 

(A) dEikbyj  (A) Compiler 

(B) baVjçsVj  (B) Interpreter 

(C) vlsacyj  (C) Assembler 

(D) lHkh leku xfr ls  (D) All are equal 

10. baVjçsVj çksxzke dks dSls pykrk gS \ 

 
10. How does an Interpreter execute a 

program ? 

(A) iwjs çksxzke dks ,d lkFk vuqokn djrk 

gS 

 (A) Translates the entire program at 

once 

(B) iafä nj iafä vuqokn vkSj fu"iknu 

djrk gS 

 (B) Translates and executes line-by-

line 

(C) dsoy MsVk laxzfgr djrk gS  (C) Only stores data 

(D) dsoy ifj.kke fn[kkrk gS  (D) Only displays output 

11. dEikbyj dk eq[; dk;Z D;k gS \ 

 
11. What is the main function of a 

Compiler ? 

(A) mPp Lrjh; Hkk"kk dks e'khu dksM esa 

cnyuk 

 (A) Converts high-level language 

into Machine code 

(B) e'khu dksM dks mPp Lrjh; Hkk"kk esa 

cnyuk 

 (B) Converts Machine code into 

high-level language 

(C) vlsacyh Hkk"kk dks e'khu dksM esa 

cnyuk 

 (C) Converts assembly language into 

Machine code 

(D) ckbujh dks n'keyo esa cnyuk  (D) Converts binary into decimal 
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12. dkSu&lk buiqV midj.k fp=ksa dks dSIpj dj 

fMftVy :i esa cnyrk gS \ 

 
12. Which input device captures images 

and converts them into digital format ? 

(A) LdSuj  (A) Scanner 

(B) fçaVj  (B) Printer 

(C) ekWfuVj  (C) Monitor 

(D) Lihdj  (D) Speaker 

13. 
-----------------

 LØhu ij n`'; vkmViqV fn[kkrk gSA 

 
13. A ……….. displays visual output on a 

screen. 

(A) ekWfuVj  (A) Monitor 

(B) fçaVj  (B) Printer 

(C) Lihdj  (C) Speaker 

(D) LdSuj  (D) Scanner 

14. dkSu&lk midj.k nLrkostksa dh gkMZ dkWih 

fudkyrk gS \ 

 
14. Which device produces hard copies of 

documents ? 

(A) ekWfuVj  (A) Monitor 

(B) fçaVj  (B) Printer 

(C) Lihdj  (C) Speaker 

(D) LdSuj  (D) Scanner 
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15. IykWVj dk mi;ksx gksrk gS % 

 
15. Plotters are used for : 

(A) cM+s xzkfQDl fçaV djus esa  (A) Printing large-scale graphics 

(B) /ofu dSIpj djus esa  (B) Capturing sound 

(C) ohfM;ks fn[kkus esa  (C) Displaying video 

(D) MsVk laxzfgr djus esa  (D) Storing data 

16. çkstsDVj gS % 

 
16. A projector is a/an : 

(A) buiqV midj.k  (A) Input device 

(B) vkmViqV midj.k  (B) Output device 

(C) LVksjst midj.k  (C) Storage device 

(D) mi;qZDr esa ls dksbZ ugha  (D) None of the above 

17. tkW;fLVd gS % 

 
17. A joystick is a/an : 

(A) buiqV midj.k  (A) Input device 

(B) vkmViqV midj.k  (B) Output device 

(C) LVksjst midj.k  (C) Storage device 

(D) mi;qZDr esa ls dksbZ ugha  (D) None of the above 

18. dkSu&lk midj.k gLrfyf[kr ikB dks 

fMftVy :i esa cnyrk gS \ 

 
18. Which device converts handwritten 

text into digital form ? 

(A) LdSuj  (A) Scanner 

(B) OCR (vkWfIVdy dSjsDVj 

fjdfXu'ku) 

 (B) OCR device (Optical Character 

Recognition)  

(C) dhcksMZ  (C) Keyboard 

(D) ekml  (D) Mouse 
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19. ;fn fdlh gkMZ fMLd dh {kerk 2 TB gS] rks 

mlesa dqy fdrus GB eseksjh gS \ 

 
19. If a hard disk has 2 TB capacity, how 

many GB does it have ? 

(A) 2000 GB  (A) 2000 GB 

(B) 4096 GB  (B) 4096 GB 

(C) 2048 GB  (C) 2048 GB 

(D) 1024 GB  (D) 1024 GB 

20. 1 esxkckbV (MB) esa fdrus ckbV~l gksrs  

gSa \ 

 
20. How many bytes are there in  

1 Megabyte (MB) ? 

(A) 1000 × 1000 = 1,000,000  (A) 1000 × 1000 = 1,000,000 

(B) 1024 × 1024 = 1,048,576  (B) 1024 × 1024 = 1,048,576 

(C) 500,000  (C) 500,000 

(D) 2,048,000  (D) 2,048,000 

21. daI;wVj LVksjst ;wfuV~l dk lgh Øe (lcls 

NksVs ls lcls cM+s rd) D;k gS \ 

 
21. Which is the correct order of computer 

storage units (smallest to largest) ? 

(A) fcV → ckbV → dsch → ,ech → 

thch → Vhch 

 (A) Bit → Byte → KB → MB → 

GB → TB  

(B) ckbV → fcV → dsch → ,ech → 

thch → Vhch 

 (B) Byte → Bit  → KB → MB → 

GB → TB 

(C) dsch → fcV → ckbV → ,uch → 

thch → Vhch 

 (C) KB →  Bit→ Byte → MB → 

GB → TB 

(D) fcV → dsch → ckbV → ,ech → 

thch → Vhch 

 (D) Bit → KB → Byte → MB → 

GB → TB 
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22. 1 fucy = ? fcV~lA 

 
22. 1 Nibble = ? Bits. 

(A) 2  (A) 2 

(B) 4  (B) 4 

(C) 8  (C) 8 

(D) 16  (D) 16 

23. fuEufyf[kr esa ls dkSu&lk RAM dk lgh 

iw.kZ :i gS \ 

 
23. Which of the following is the correct 

full form of RAM ? 

(A) jhM ,Dlsl eseksjh  (A) Read Access Memory 

(B) jSaMe ,Dlsl eseksjh  (B) Random Access Memory 

(C) jSfiM ,Dlsl eseksjh  (C) Rapid Access Memory 

(D) fj;y ,Dlsl eseksjh  (D) Real Access Memory 

24. fuEufyf[kr esa ls dkSu&lh daI;wVj dh ih<+h 

ugha gS \ 

 
24. Which of the following is not a 

generation of computers ? 

(A) igyh ih<+h  (A) First Generation 

(B) nwljh ih<+h  (B) Second Generation 

(C) pkSFkh ih<+h  (C) Fourth Generation 

(D) lkroha ih<+h  (D) Seventh Generation 

25. fuEufyf[kr esa ls dkSu&lk GUI dk lgh iw.kZ 

:i gS \ 

 
25. Which of the following is the correct 

full form of GUI ? 

(A) xzkfQdy ;wtj baVjQsl  (A) Graphical User Interface 

(B) tujy ;wfVfyVh buiqV  (B) General Utility Input 

(C) Xykscy ;wtj baVjusV  (C) Global User Internet 

(D) xzkfQdy ;wfVfyVh baVjsD'ku  (D) Graphical Utility Interaction 
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26. fuEufyf[kr esa ls dkSu&lk daI;wVj eseksjh dk 

,d çdkj gS tks LFkk;h gksrh gS \ 

 
26. Which of the following is a type of 

computer memory that is permanent ? 

(A) jSe  (A) RAM 

(B) dS'k  (B) Cache 

(C) jftLVj  (C) Register 

(D) jkse  (D) ROM 

27. fuEufyf[kr esa ls dkSu&lk lkW¶Vos;j dk 

mnkgj.k gS \ 

 
27. Which of the following is an example 

of software ? 

(A) ekml  (A) Mouse 

(B) foaMkst vkWijsfVax flLVe  (B) Windows Operating System 

(C) fçaVj  (C) Printer 

(D) gkMZ fMLd  (D) Hard Disk 

28. MODEM dk mi;ksx fdlds fy, fd;k 

tkrk gS \ 

 
28. What is a MODEM used for ? 

(A) daI;wVj dks fçaVj ls tksM+us ds fy,  (A) To connect a computer to a 

printer 

(B) daI;wVj dks baVjusV ls tksM+us ds fy,  (B) To connect a computer to the 

Internet 

(C) daI;wVj dks ekWfuVj ls tksM+us ds fy,  (C) To connect a computer to a 

monitor 

(D) daI;wVj dks dhcksMZ ls tksM+us ds fy,  (D) To connect a computer to a 

keyboard 
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29. ekWMse dk eq[; dk;Z D;k gS \ 

 
29. What is the main function of a  

Modem ? 

(A) ,ukykWx flXuy dks fMftVy flXuy 

esa ifjofrZr djuk 

 (A) Convert analog signals to digital 

signals 

(B) fMftVy flXuy dks ,ukykWx flXuy 

esa ifjofrZr djuk 

 (B) Convert digital signals to analog 

signals 

(C) nksuksa (A) vkSj (B)  (C) Both (A) and (B) 

(D) mi;qZDr esa ls dksbZ ugha  (D) None of the above 

30. ekWMse fdl çdkj dk midj.k gS \ 

 
30. What type of device is a Modem ? 

(A) buiqV midj.k  (A) Input device 

(B) vkmViqV midj.k  (B) Output device 

(C) lapkj midj.k  (C) Communication device 

(D) HkaMkj.k midj.k  (D) Storage device 

31. ekWMse dk iwjk uke D;k gS \ 

 
31. What is the full form of Modem ? 

(A) ekWMîqysVj&MhekWMîwysVj  (A) Modulator-Demodulator 

(B) ekWMuZ ,E;qysVj  (B) Modern Emulator 

(C) ekWMîqyj fMokbl  (C) Modular Device 

(D) eksM e'khu  (D) Mode Machine 
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32. ALU dk iwjk uke D;k gS \ 

 
32. What does ALU stand for ? 

(A) vkWVkseSfVd ykWftd ;wfuV  (A) Automatic Logic Unit 

(B) ,MokaLM ykWftd ;wfuV  (B) Advanced Logic Unit 

(C) vYxksfjn~fed ykWftd ;wfuV  (C) Algorithmic Logic Unit 

(D) vfjFkeSfVd ykWftd ;wfuV  (D) Arithmetic Logic Unit 

33. gsDlkMsfley la[;k i¼fr dk vk/kkj D;k  

gS \ 

 
33. Which of the following is the base of 

hexadecimal system ? 

(A) 2  (A) 2 

(B) 8  (B) 8 

(C) 10  (C) 10 

(D) 16  (D) 16 

34. ckbujh 1111 dk n'keyo :i D;k gksxk \ 

 
34. Convert binary 1111 to decimal : 

(A) 15  (A) 15 

(B) 16  (B) 16 

(C) 14  (C) 14 

(D) 13  (D) 13 

35. n'keyo 20 dk ckbujh :i D;k gksxk \ 

 
35. Convert decimal 20 to binary : 

(A) 10100  (A) 10100 

(B) 11000  (B) 11000 

(C) 11100  (C) 11100 

(D) 10010  (D) 10010 
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36. ckbujh la[;k i¼fr esa dkSu&ls vad ç;qä 

gksrs gSa \ 

 
36. Binary number system uses which 

digits ? 

(A) 0-9  (A) 0-9 

(B) 0-7  (B) 0-7 

(C) 0-1  (C) 0-1 

(D) 0-F  (D) 0-F 

37. fuEufyf[kr esa ls dkSu&lh vLFkk;h Lèfr gS \ 

 
37. Which of the following is a volatile 

memory ? 

(A) ROM  (A) ROM 

(B) RAM  (B) RAM 

(C) gkMZ fMLd  (C) Hard Disk 

(D) lhMh&jkse  (D) CD-ROM 

38. fuEufyf[kr esa ls dkSu&lk f}rh;d Le`fr 

midj.k gS \ 

 
38. Which of the following is a secondary 

storage device ? 

(A) RAM  (A) RAM 

(B) dS'k  (B) Cache 

(C) gkMZ fMLd  (C) Hard Disk 

(D) jftLVj  (D) Register 

39. fuEufyf[kr esa ls dkSu&lh ikWbafVax ,d 

fMokbl gS \ 

 
39. Which of the following is a pointing 

device ? 

(A) dhcksMZ  (A) Keyboard 

(B) ekml  (B) Mouse 

(C) fçaVj  (C) Printer 

(D) LdSuj  (D) Scanner 
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40. fuEufyf[kr esa ls dkSu&lk buiqV midj.k gS \ 

 
40. Which device is an input peripheral ? 

(A) fçaVj  (A) Printer 

(B) LdSuj  (B) Scanner 

(C) ekWfuVj  (C) Monitor 

(D) Lihdj  (D) Speaker 

41. fdl ih<+h esa ekbØksçkslslj dk ç;ksx gqvk \ 

 
41. Which generation introduced 

microprocessors ? 

(A) nwljh  (A) Second 

(B) rhljh  (B) Third 

(C) pkSFkh  (C) Fourth 

(D) ik¡poha  (D) Fifth 

42. fMftVy daI;wVj MsVk dks fdlesa çnf'kZr 

djrs gSa \ 

 
42. Digital computers represent data  

using : 

(A) ckbujh ç.kkyh  (A) Binary system 

(B) n'keyo ç.kkyh  (B) Decimal system 

(C) vkWDVy ç.kkyh  (C) Octal system 

(D) gsDlkMsfley ç.kkyh  (D) Hexadecimal system 

43. çkFkfed eseksjh dks vkSj fdl uke ls tkuk 

tkrk gS \ 

 
43. Primary memory is also known as : 

(A) gkMZ fMLd  (A) Hard Disk 

(B) isu Mªkbo  (B) Pen Drive 

(C) CD-ROM  (C) CD-ROM 

(D) RAM  (D) RAM 
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44. nwljh ih<+h ds daI;wVj fdl ij vk/kkfjr  

Fks \ 

 
44. The second generation of computers 

was based on : 

(A) oSD;we Vîwc  (A) Vacuum tubes 

(B) VªkaftLVj  (B) Transistors 

(C) ICs  (C) ICs 

(D) Ïf=e cqf¼eÙkk  (D) Artificial Intelligence 

45. dkSu&lk ;wfuV xf.krh; vkSj rkfdZd fØ;k,¡ 

djrk gS \ 

 
45. The unit that performs arithmetic and 

logical operations is : 

(A) daVªksy ;wfuV  (A) Control Unit 

(B) ALU  (B) ALU 

(C) eseksjh ;wfuV  (C) Memory Unit 

(D) buiqV ;wfuV  (D) Input Unit 

46. fdl ih<+h esa baVhxzsVsM lfdZV (ICs) dk ç;ksx 

gqvk \ 

 
46. Which generation marked the use of 

Integrated Circuits (ICs) ? 

(A) igyh  (A) First 

(B) nwljh  (B) Second 

(C) rhljh  (C) Third 

(D) pkSFkh  (D) Fourth 
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47. dkSu&lk ;wfuV MsVk vkSj funsZ'kksa ds çokg dks 

fu;af=r djrk gS \ 

 
47. Which unit directs the flow of data and 

instructions ? 

(A) ALU  (A) ALU 

(B) daVªksy ;wfuV  (B) Control Unit 

(C) buiqV ;wfuV  (C) Input Unit 

(D) vkmViqV ;wfuV  (D) Output Unit 

48. daI;wVj dk efLr"d dgykrk gS % 

 
48. The brain of the computer is : 

(A) RAM  (A) RAM 

(B) CPU  (B) CPU 

(C) gkMZ fMLd  (C) Hard Disk 

(D) ekWfuVj  (D) Monitor 

49. fuEufyf[kr esa ls dkSu&lk vkmViqV midj.k 

gS \ 

 
49. Which of the following is an output 

device ? 

(A) LdSuj  (A) Scanner 

(B) ekml  (B) Mouse 

(C) ekWfuVj  (C) Monitor 

(D) dhcksMZ  (D) Keyboard 

50. çFke ih<+h ds daI;wVj esa D;k ç;ksx gqvk Fkk \ 

 
50. The first generation of computers used : 

(A) VªkaftLVj  (A) Transistors 

(B) oSD;we Vîwc  (B) Vacuum tubes 

(C) baVhxzsVsM lfdZV  (C) Integrated circuits 

(D) ekbØksçkslslj  (D) Microprocessors 
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51. ;wfVfyVh lkW¶Vos;j eq[; :i ls fuEu dk;ks± 

ds fy, fMtkbu fd;k x;k gS % 

 
51. Utility software is primarily designed 

to : 

(A) oMZ çkslsflax tSls fof'k"V mi;ksxdrkZ 

dk;ks± dks djuk 

 (A) Perform specific user tasks like 

word processing 

(B) daI;wVj lalk/kuksa dk çca/ku vkSj 

j[kj[kko djuk 

 (B) Manage and maintain computer 

resources 

(C) vkWijsfVax flLVe dks çfrLFkkfir djuk  (C) Replace the operating system 

(D) LFkk;h laxzg.k çnku djuk  (D) Provide permanent storage 

52. vkWijsfVax flLVe dk eq[; mís'; gS % 

 
52. The main purpose of an operating 

system is to : 

(A) çksxzkeksa dks daikby djuk  (A) Compile programs 

(B) gkMZos;j vkSj lkW¶Vos;j lalk/kuksa dk 

çca/ku djuk 

 (B) Manage hardware and software 

resources 

(C) LFkk;h HkaMkj.k çnku djuk  (C) Provide permanent storage 

(D) baVjusV ls tqM+uk  (D) Connect to the internet 

53. fuEufyf[kr esa ls dkSu&lk vkWijsfVax flLVe 

ugha gS \ 

 
53. Which of the following is not an 

operating system ? 

(A) foaMkst  (A) Windows 

(B) fyuDl  (B) Linux 

(C) vksjsdy  (C) Oracle 

(D) eSd vks,l  (D) macOS 
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54. dS'k eseksjh dk mi;ksx djus dk eq[; ykHk 

D;k gS \ 

 
54. What is the main advantage of using 

cache memory ? 

(A) lhih;w dh ykxr de djrk gS  (A) Reduces cost of CPU 

(B) MsVk HkaMkj.k {kerk c<+krk gS  (B) Increases data storage capacity 

(C) ,Dlsl le; de djds lhih;w ds 

çn'kZu esa lq/kkj djrk gS 

 (C) Improves CPU performance by 

reducing access time 

(D) LFkk;h HkaMkj.k çnku djrk gS  (D) Provides permanent storage 

55. SPSS esa dkSu&lh foaMks dPps MsVk dks 

fn[kkrh gS ftls laikfnr fd;k tk ldrk gS \ 

 
55. Which window in SPSS shows the raw 

data that can be edited ? 

(A) vkmViqV foaMks  (A) Output Window 

(B) MsVk O;w  (B) Data View 

(C) osfj,cy O;w  (C) Variable View 

(D) flaVSDl ,fMVj  (D) Syntax Editor 

56. SPSS dk iwjk uke D;k gS \ 

 
56. What does SPSS stand for ? 

(A) LVSfVfLVdy iSdst QkWj lks'ky 

lkbalst 

 (A) Statistical Package for Social 

Sciences 

(B) LVSfVfLVdy çksxzke QkWj lSaiy losZ  (B) Statistical Program for Sample 

Survey 

(C) LVSfVfLVdy IysVQkWeZ QkWj losZ 

lkWY;w'kal 

 (C) Statistical Platform for Survey 

Solutions 

(D) LVSfVfLVdy çkslsflax ,aM losZ flLVe  (D) Statistical Processing and Survey 

System 
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57. SPSS vkmViqV Qkbyksa dk ,DlVsa'ku D;k 

gksrk gS \ 

 
57. What is the file extension for SPSS 

output files ? 

(A) .sav  (A) .sav 

(B) .spv  (B) .spv 

(C) .sps  (C) .sps 

(A) .spo  (D) .spo 

58. SPSS esa Frequency Distribution fudkyus 

ds fy, dkSu&lk fodYi ç;ksx gksrk gS \ 

 
58. Which option is used to generate 

frequency distribution in SPSS ? 

(A) Analyze → Descriptive Statistics 

→ Frequencies 

 (A) Analyze → Descriptive Statistics 

→ Frequencies 

(B) Analyze → Compare Means  (B) Analyze → Compare Means 

(C) Graphs → Chart Builder  (C) Graphs → Chart Builder 

(D) Data → Sort Cases  (D) Data → Sort Cases 

59. SPSS esa dkyZ fi;lZu lglaca/k xq.kkad 

ekirk gS % 

 
59. The Karl Pearson correlation 

coefficient in SPSS measures : 

(A) pjksa ds chp dkj.k laca/k  (A) Causation between variables 

(B) nks lrr pjksa ds chp jSf[kd laca/k  (B) Linear relationship between two 

continuous variables 

(C) pjksa ds chp ?kkrh; laca/k  (C) Exponential relationship 

between variables 

(D) Js.khc¼ pjksa ds chp laca/k  (D) Relationship between categorical 

variables 
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60. vki SPSS esa is;MZ lSaiYl t&ijh{k.k dk 

mi;ksx dc djsaxs \ 

 
60. When would you use a paired samples 

t-test in SPSS ? 

(A) nks Lora= lewgksa ds ek/;ksa dh rqyuk 

djrs le; 

 (A) When comparing means from 

two independent groups 

(B) uewuk ek/; dh rqyuk ,d Kkr eku ls 

djrs le; 

 (B) When comparing a sample mean 

to a known value 

(C) ,d gh lewg ds ek/;ksa dh nks 

vyx&vyx le; ij rqyuk djrs 

le; 

 (C) When comparing means from 

the same group at two different 

times 

(D) rhu ;k vf/kd lewgksa ds ek/;ksa dh 

rqyuk djrs le; 

 (D) When comparing means from 

three or more groups 

61. SPSS esa MsVk ,aVªh fdl O;w esa dh tkrh gS \ 

 
61. In which view is data entered in SPSS ? 

(A) Variable View  (A) Variable View 

(B) Data View  (B) Data View 

(C) Output View  (C) Output View 

(D) Syntax View  (D) Syntax View 

62. SPSS MsVk Qkbyksa ds fy, fMQkWYV Qkby 

,DlVsa'ku D;k gS \ 

 
62. Which is the default file extension for 

SPSS data files ? 

(A) .spss  (A) .spss 

(B) .sav  (B) .sav 

(C) .sps  (C) .sps 

(D) .spv  (D) .spv 

63. R esa fdlh U;wesfjd osDVj dk vkSlr 

fudkyus ds fy, dkSu&lk QaD'ku ç;ksx gksrk 

gS \ 

 
63. Which function in R calculates the 

mean of a numeric vector ? 

(A) mean()  (A) mean()  

(B) average()  (B) average()  

(C) median()  (C) median()  

(D) summary()  (D) summary()  
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64. R esa lkjka'k vk¡dM+s (min, max, mean, 

median vkfn) çkIr djus ds fy, dkSu&lk 

QaD'ku ç;ksx gksrk gS \ 

 
64. Which function in R gives summary 

statistics (min, max, mean, median, 

etc.) ? 

(A) describe()  (A) describe()  

(B) summary()  (B) summary()  

(C) stats()  (C) stats()  

(D) details()  (D) details()  

65. plot () esa fcanqvksa ds vkdkj fu;af=r djus ds 

fy, dkSu&lk vkX;ZqesaV ç;ksx gksrk gS \ 

 
65. Which argument in plot() controls the 

plotting symbol style (shape of points) ? 

(A) pch  (A) pch 

(B) col  (B) col 

(C) lty  (C) lty 

(D) cex  (D) cex 

66. plot() esa x&v{k dk yscy lsV djus ds fy, 

dkSu&lk vkX;ZqesaV ç;ksx gksrk gS \ 

 
66. Which argument in plot() is used to 

label the x-axis ? 

(A) xlabel  (A) xlabel 

(B) xlab  (B) xlab 

(C) axisx  (C) axisx 

(D) labelx  (D) labelx 

67. csl xzkfQDl iSdst ls fgLVksxzke cukus ds 

fy, fdl R QaD'ku dk mi;ksx fd;k tkrk 

gS \ 

 
67. Which R function is used to create a 

histogram from the base graphics 

package is  ? 

(A) hist()  (A) hist()  

(B) histogram()  (B) histogram()  

(C) barplot()  (C) barplot()  

(D) pie()  (D) pie()  
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68. plot (x, y, type="1") esa vkX;qZesaV "1" dk 

vFkZ D;k gS \ 

 
68. What does the argument type=“1” in 

plot (x, y, type="1") specify ? 

(A) ykbu xzkQ  (A) Line graph 

(B) ykWxfjn~fed Ldsy  (B) Logarithmic scale 

(C) ystsaM  (C) Legend 

(D) yscy  (D) Labels 

69. R esa LdSVj IykWV cukus ds fy, dkSu&lk 

QaD'ku ç;ksx gksrk gS \ 

 
69. Which function in R is used to create a 

scatter plot ? 

(A) scatter()  (A) scatter()  

(B) plot()  (B) plot()  

(C) graph()  (C) graph()  

(D) points()  (D) points()  

70. R esa oSDVj ds ckjs esa fuEufyf[kr esa ls 

dkSu&lk dFku lgh gS \ 

 
70. Which of the following statements 

about vectors in R is correct ? 

(A) oSDVj fcuk :ikarj.k ds dbZ 

vyx&vyx MsVk çdkjksa ds rRoksa dks 

laxzghr dj ldrs gSaA 

 (A) Vectors can store elements of 

multiple different data types 

without conversion 

(B) oSDVj ,d&vk;keh gksrs gSa vkSj lHkh 

rRo ,d gh çdkj ds gksus pkfg,A 

 (B) Vectors are one-dimensional and 

all elements must be of the same 

type 

(C) oSDVj ges'kk eSfVªDl dh rjg 

f}&vk;keh gksrs gSaA 

 (C) Vectors are always two-

dimensional like matrices 

(D) oSDVj dk mi;ksx vadxf.krh; 

lafØ;kvksa esa ugha fd;k tk ldrk gSA 

 (D) Vectors cannot be used in 

arithmetic operations 
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71. R esa fdlh pj dks eku fufnZ"V djus dk 

fuEufyf[kr esa ls dkSu&lk oS/k rjhdk gS \ 

 
71. Which of the following is a valid way 

to assign a value to a variable in R ? 

(A) x = 10  (A) x = 10 

(B) x <- 10  (B) x <- 10 

(C) 10 -> x  (C) 10 -> x 

(D) mi;qZDr lHkh  (D) All of the above 

72. R esa osfj,cYl ds ckjs esa fuEufyf[kr esa ls 

dkSu&lk dFku lgh gS \ 

 
72. Which of the following statements 

about variables in R is correct ? 

(A) osfj,cy ds uke la[;k ls 'kq: gks 

ldrs gSa 

 (A) Variable names can start with a 

number 

(B) osfj,cy ds uke dsl&lsaflfVo gksrs gSa  (B) Variable names are case-

sensitive 

(C) osfj,cy ds ukeksa esa vaMjLdksj ugha gks 

ldrs 

 (C) Variable names cannot contain 

underscores 

(D) osfj,cy ds uke ges'kk vijdsl esa 

gksus pkfg, 

 (D) Variable names must always be 

uppercase 

73. append() QaD'ku esa dkSu&lk vkX;ZqesaV ;g 

fufnZ"V djrk gS fd u, ,fyesaV dgk¡ Mkys 

tkus pkfg, \ 

 
73. Which argument in the append() 

function specifies the position where 

new elements should be inserted ? 

(A) after  (A) after 

(B) pos  (B) pos 

(C) index  (C) index 

(D) insert  (D) insert 
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74. R esa append(c(1,2,3), 4) dk ifj.kke D;k 

gksxk \ 

 
74. What will be the result of 

append(c(1,2,3), 4) in R ? 

(A) c(1,2,3)  (A) c(1,2,3)  

(B) c(1,2,3,4)  (B) c(1,2,3,4)  

(C) c(4,1,2,3)  (C) c(4,1,2,3)  

(D) =qfV  (D) Error 

75. R esa is.logical(TRUE) dk ifj.kke D;k 

gksxk \ 

 
75. What will be the result of 

is.logical(TRUE)  in R ? 

(A) "TRUE"  (A) “TRUE” 

(B) TRUE  (B) TRUE 

(C) ykWftdy  (C) Logical 

(D) =qfV  (D) Error 

76. R esa dkSu&lk QaD'ku eSfVªDl dks MsVk Ýse esa 

ifjofrZr djrk gS \ 

 
76. Which function converts a matrix to a 

data frame in R ? 

(A) as.data.frame()  (A) as.data.frame()  

(B) data.frame()  (B) data.frame()  

(C) df()  (C) df()  

(D) convert()  (D) convert()  

77. matrix(1:6, nrow=2, byrow=TRUE) D;k 

mRiUu djsxk \ 

 
77. What will matrix(1:6, nrow=2, 

byrow=TRUE) produce ? 

(A) dkWye&okj Hkjk gqvk 2×3 eSfVªDl  (A) 2×3 matrix filled column-wise 

(B) iafä&okj Hkjk gqvk 2×3 eSfVªDl  (B) 2×3 matrix filled row-wise 

(C) iafä&okj Hkjk gqvk 3×2 eSfVªDl  (C) 3×2 matrix filled row-wise 

(D) =qfV  (D) Error 



B060601T ( 25 )  Set-D 

78. length(c(TRUE, FALSE, TRUE)) dk 

vkmViqV D;k gS \ 

 
78. What is the output of length(c(TRUE, 

FALSE, TRUE) ) ? 

(A) 2  (A) 2 

(B) 3  (B) 3 

(C) 1  (C) 1 

(D) =qfV  (D) Error 

79. R esa fdlh lwph 1 ds nwljs rRo dks dSls 

çkIr fd;k tk ldrk gS \ 

 
79. How do you access the second element 

of a list 1 in R ? 

(A) 1[2]  (A) 1[2] 

(B) 1[[2]]  (B) 1[[2]] 

(C) 1(2)  (C) 1(2)  

(D) 1{2}  (D) 1{2} 

80. R esa osDVj cukus ds fy, fdl QaD'ku dk 

mi;ksx fd;k tkrk gS \ 

 
80. Which function is used to create a 

vector in R ? 

(A) vector()  (A) vector()  

(B) c()  (B) c()  

(C) v()  (C) v()  

(D) list()  (D) list()  

81. eSfVªDl m dh nwljh iafä vkSj rhljs LraHk esa 

fLFkr rRo dks vki dSls çkIr djsaxs \ 

 
81. How do you access the element in  

the 2nd row and 3rd column of a 

matrix m ? 

(A) m[2, 3]  (A) m[2,3] 

(B) m (2, 3)  (B) m(2,3)  

(C) m{2, 3}  (C) m{2,3} 

(D) m[3, 2]  (D) m[3,2] 
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82. R esa 3 + 4 * 2 ^ 2 dk ifj.kke D;k  

gksxk \ 

 
82. What will be the output of  

3 + 4 * 2 ^ 2 in R ? 

(A) 28  (A) 28 

(B) 19  (B) 19 

(C) 22  (C) 22 

(D) 11  (D) 11 

83. R esa 7 %% 3 dk ifj.kke D;k gksxk \ 

 
83. What will 7 %% 3 return in R ? 

(A) 1  (A) 1 

(B) 2  (B) 2 

(C) 3  (C) 3 

(D) 4  (D) 4 

84. R esa vlkbuesaV ds fy, dkSu&lk vkWijsVj 

ç;ksx fd;k tkrk gS \ 

 
84. Which operator is used for assignment 

in R ? 

(A) =  (A) = 

(B) <-  (B) <- 

(C) ->  (C) -> 

(D) mi;qZDr lHkh  (D) All of the above 

85. R esa TRUE | FALSE dk ifj.kke D;k  

gksxk \ 

 
85. What will be the result of TRUE | 

FALSE in R ? 

(A) TRUE  (A) TRUE 

(B) FALSE  (B) FALSE 

(C) =qfV  (C) Error 

(D) mi;qZDr esa ls dksbZ ugha  (D) None of the above 
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86. R esa iw.kk±d foHkktu ds fy, dkSu&lk 

vkWijsVj ç;ksx gksrk gS \ 

 
86. Which operator is used for integer 

division in R ? 

(A) /  (A) / 

(B) % / %  (B) %/% 

(C) %%  (C) %% 

(D) ^  (D) ^ 

87. R esa ykWftdy AND ds fy, dkSu&lk 

vkWijsVj ç;ksx gksrk gS \ 

 
87. Which operator is used for logical 

AND in R ? 

(A) &  (A) & 

(B) &&  (B) && 

(C) nksuksa (A) vkSj (B)  (C) Both (A) and (B) 

(D) ||  (D) || 

88. RStudio esa dalksy dks lkQ djus ds fy, 

dkSu&lk 'kkWVZdV dqath ç;ksx gksrh gS \ 

 
88. Which shortcut key is used to clear the 

console in RStudio ? 

(A) Ctrl + C  (A) Ctrl + C 

(B) Ctrl + Enter  (B) Ctrl + Enter 

(C) Ctrl + L  (C) Ctrl + L 

(D) Ctrl + Shift  (D) Ctrl + Shift 

89. R fdu vkWijsfVax flLVe ij pyrk gS \ 

 
89. Which operating systems support R ? 

(A) dsoy Windows  (A) Windows only 

(B) dsoy Linux  (B) Linux only 

(C) dsoy macOS  (C) macOS only 

(D) Windows, Linux vkSj macOS  (D) Windows, Linux, and macOS 
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90. CRAN dk iwjk uke D;k gS % 

 
90. CRAN stands for : 

(A) Central R Archive Network  (A) Central R Archive Network 

(B) Comprehensive R Archive 

Network 

 (B) Comprehensive R Archive 

Network 

(C) Common R Application Network  (C) Common R Application 

Network 

(D) Complete R Access Node  (D) Complete R Access Node 

91. R esa lgk;rk çkIr djus ds fy, dkSu&lk 

QaD'ku ç;ksx gksrk gS \ 

 
91. Which of the following functions is 

used to get help in R ? 

(A) help()  (A) help()  

(B) info()  (B) info()  

(C) support()  (C) support()  

(D) manual()  (D) manual()  

92. CRAN dk fMQkWYV fejj dgk¡ fLFkr gS \ 

 
92. The default CRAN mirror is located  

in : 

(A) vesfjdk  (A) USA 

(B) fczVsu  (B) UK 

(C) vkWfLVª;k  (C) Austria 

(D) Hkkjr  (D) India 

93. R ds ckjs esa dkSu&lk dFku lgh gS \ 

 
93. Which of the following is TRUE about 

R ? 

(A) R eqä lzksr vkSj fu%'kqYd gS  (A) R is open-source and free to use 

(B) R LokfeRo lkW¶Vos;j gS  (B) R is proprietary software 

(C) R xzkfQDl ds fy, ç;ksx ugha fd;k 

tk ldrk 

 (C) R cannot be used for graphics 

(D) R dsoy Windows ij pyrk gS  (D) R runs only on Windows 
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94. R dk laLdj.k tk¡pus ds fy, dkSu&lk 

vkns'k ç;ksx gksrk gS \ 

 
94. Which command is used to check the 

version of R ? 

(A) version()  (A) version()  

(B) R.version()  (B) R.version()  

(C) getVersion()  (C) getVersion()  

(D) checkVersion()  (D) check Version()  

95. RStudio dk dalksy fdlds fy, ç;ksx gksrk 

gS \ 

 
95. The console in RStudio is used  

for : 

(A) dksM fy[kus ds fy,  (A) Writing code 

(B) vkns'kksa dks baVjSfDVo :i ls pykus ds 

fy, 

 (B) Executing commands inter-

actively 

(C) Qkby çca/ku ds fy,  (C) Managing files 

(D) R LFkkfir djus ds fy,  (D) Installing R 

96. RStudio D;k gS \ 

 
96. RStudio is : 

(A) ,d çksxzkfeax Hkk"kk  (A) A programming language 

(B) R ds fy, ,d IDE  (B) An Integrated Development 

Environment (IDE) for R 

(C) ,d MsVkcsl flLVe  (C) A database system 

(D) ,d dEikbyj  (D) A compiler 
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97. R fLØIV dh fMQkWYV Qkby ,DlVsa'ku D;k 

gS \ 

 
97. The default file extension for R scripts 

is : 

(A) .exe  (A) .exe 

(B) .txt  (B) .txt 

(C) .R  (C) .R 

(D) .rs  (D) .rs 

98. R fdl çdkj dh Hkk"kk gS \ 

 
98. R is an example of : 

(A) dEikbYM Hkk"kk  (A) Compiled language 

(B) baVjçsVsM Hkk"kk  (B) Interpreted language 

(C) vlsacyh Hkk"kk  (C) Assembly language 

(D) e'khu Hkk"kk  (D) Machine language 

99. R fdlus fodflr fd;k \ 

 
99. R was developed by : 

(A) Msful fjph  (A) Dennis Ritce 

(C) jkWl bgkdk vkSj jkWcVZ tsaVyeSu  (B) Ross Ihaka and Robert 

Gentleman 

(C) tsEl xkWlfyax  (C) James Gosling 

(D) xqbMks oSu jkWle  (D) Guido van Rossum 

100. R dk eq[; mi;ksx fdlds fy, gksrk gS \ 

 
100. R is mainly used for : 

(A) osc fodkl  (A) Web development 

(C) lkaf[;dh; x.kuk vkSj xzkfQDl  (B) Statistical computing and 

graphics 

(C) vkWijsfVax flLVe  (C) Operating systems 

(D) usVofd±x  (D) Networking 
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4. Four alternative answers are mentioned for 

each question as—A, B, C & D in the 

booklet. The candidate has to choose the  

correct answer and mark the same in the 

OMR Answer-Sheet as per the direction : 

 4. iz'u&iqfLrdk esa izR;sd iz'u ds pkj lEHkkfor 

mÙkjµA, B, C ,oa D gSaA ijh{kkFkhZ dks mu pkjksa 

fodYiksa esa ls lgh mÙkj Nk¡Vuk gSA mÙkj dks OMR 

vkUlj&'khV esa lEcfU/kr iz'u la[;k esa fuEu izdkj 

Hkjuk gS % 

Example :  
mnkgj.k % 

Question :  
iz'u % 

Q. 1  iz'u 1 

Q. 2  iz'u 2 

Q. 3  iz'u 3 

Illegible answers with cutting and  

over-writing or half filled circle will be 

cancelled. 

 viBuh; mÙkj ;k ,sls mÙkj ftUgsa dkVk ;k cnyk x;k 

gS] ;k xksys esa vk/kk Hkjdj fn;k x;k] mUgsa fujLr dj 

fn;k tk,xkA 

5. Each question carries equal marks. Marks 
will be awarded according to the number of 
correct answers you have. 

 5. izR;sd iz'u ds vad leku gSaA vkids ftrus mÙkj lgh 

gksaxs] mUgha ds vuqlkj vad iznku fd;s tk;saxsA 

6. All answers are to be given on OMR 
Answer Sheet only. Answers given 
anywhere other than the place specified in 
the answer sheet will not be considered 
valid. 

 6. lHkh mÙkj dsoy vks- ,e- vkj- mÙkj&i=d (OMR 

Answer Sheet) ij gh fn;s tkus gSaA mÙkj&i=d esa 

fu/kkZfjr LFkku ds vykok vU;= dgha ij fn;k x;k 

mÙkj ekU; ugha gksxkA 

7. Before writing anything on the OMR 
Answer Sheet, all the instructions given in it 
should be read carefully.  

 7. vks- ,e- vkj- mÙkj&i=d (OMR Answer Sheet) 

ij dqN Hkh fy[kus ls iwoZ mlesa fn;s x;s lHkh vuqns'kksa 

dks lko/kkuhiwoZd i<+ fy;k tk;sA 

8. After the completion of the examination 

candidates should leave the examination hall 

only after providing their OMR Answer 

Sheet to the invigilator. Candidate can carry 

their Question Booklet. 

 8. ijh{kk lekfIr ds mijkUr ijh{kkFkhZ d{k fujh{kd dks 

viuh OMR Answer Sheet miyC/k djkus ds ckn 

gh ijh{kk d{k ls izLFkku djsaA ijh{kkFkhZ vius lkFk 

iz'u&iqfLrdk ys tk ldrs gSaA 

9. There will be no negative marking.  9. fuxsfVo ekfd±x ugha gSA 

10. Rough work, if any, should be done on the 

blank pages provided for the purpose in the 

booklet. 

 10. dksbZ Hkh jQ dk;Z  iz'u&iqfLrdk ds vUr esa] jQ&dk;Z ds 

fy, fn, [kkyh ist ij gh fd;k tkuk pkfg,A 

11. To bring and use of log-book, calculator, 

pager and cellular phone in examination hall 

is prohibited. 

 11. ijh{kk&d{k esa ykWx&cqd] dSydqysVj] istj rFkk 

lsY;qyj Qksu ys tkuk rFkk mldk mi;ksx djuk oftZr 

gSA  

12. In case of any difference found in English 

and Hindi version of the question, the 

English version of the question will be held 

authentic. 

 12. iz'u ds fgUnh ,oa vaxzsth :ikUrj.k esa fHkUurk gksus dh 

n'kk esa iz'u dk vaxzsth :ikUrj.k gh ekU; gksxkA 

Impt. : On opening the question booklet, first check that all 

the pages of the question booklet are printed properly. 

If there is any discrepancy in the question Booklet, 

then after showing it to the invigilator, get another 

question Booklet of the same series. 

 egRoiw.kZ % iz'uiqfLrdk [kksyus ij izFker% tk¡p dj ns[k ysa fd 

iz'u&iqfLrdk ds lHkh i"̀B HkyhHkk¡fr Nis gq, gSaA ;fn 

iz'uiqfLrdk esa dksbZ deh gks] rks d{kfujh{kd dks fn[kkdj 

mlh fljht dh nwljh iz'u&iqfLrdk izkIr dj ysaaA 


